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Chapter 1: Release Notes introduction

These Release Notes summarize the changes made for Teamcenter 11.6 lifecycle visualization,
encompassing all of the stand-alone Lifecycle Visualization products.
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Chapter 2: Lifecycle Visualization products

Teamcenter lifecycle visualization is available in multiple product configurations, some of which also
support optional software modules.

Note

For the latest information on optional modules, licensing requirements, and pricing, see
your Siemens PLM sales representative.

For more information about system hardware and software requirements, see the hardware
and software certifications page on GTAC.

http://www.plm.automation.siemens.com/locale/support/gtac/certifications.shtml

Base

Base is the entry-level viewer product configuration in the Lifecycle Visualization family of products.
Providing powerful 2D viewing and markup capabilities along with basic 3D viewing functionality,
Base is an ideal solution for the visualization of the many 2D and 3D file formats supported.

Features provided by Base include:

• Access to more than 40 2D file types

• A rich set of 2D navigation tools (pan, zoom, page changing, etc.)

• 2D adjust

• 2D markups and 2D GD&T markups

• 2D measurements

• 2D comparisons

• 2D printing

• 2D image capture

• 2D Snapshots

• Option to save and load session files containing 2D and 3D content

• Option to open and save .plmxml files

• .jt file support

• Direct read of Solid Edge and NX formats
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Chapter 2: Lifecycle Visualization products

• Visualize 4GD worksets

• 3D viewing

• 3D navigation tools (pan, zoom, rotate, fit all, zoom area, and seek)

• Standard views (view only)

• Basic support for product structure

• Basic 3D properties viewing

• Product and Manufacturing Information (PMI) viewing

• Basic 3D cross section functionality

• Basic 3D markup and 3D GD&T markup functionality (view only)

• Basic 3D measurement functionality (single and double only)

• Quick Pick, Smart Pick, and selection preview when selecting part features

• Basic 3D printing

• 3D Snapshots

• Ability to export images to popular formats (.jpg, .png, .bmp, .tiff, .hpgl, and more)

• Peer-to-Peer conferencing

• PDM integration

Base supports the following optional features:

• ECAD Viewer (PCB and Schematic file viewing, markup, measurement, DFx, and printing)

Standard

Standard provides an integrated environment for viewing data from multiple sources, including CAD,
ERP, PDM, and legacy systems. An easy-to-learn user interface encourages collaboration among
users without requiring complex training.

Features provided by Standard include:

• All the functionality provided by Base

• Direct read of 3D VRML and STL formats

• Advanced 3D viewing

• Enhanced navigation features

• Ability to view and interact with product structure

• Selecting parts by area or volume
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• Ability to control visibility by layers defined in the CAD environment

• Advanced 3D measurements

• 3D markups and 3D GD&T markups

• 3D image capture

• Enhanced .plmxml file support

• Vis Issues Manager

Standard supports the following optional features:

• ECAD Viewer

Standard supports the following optional file converters:

• IGES

• STEP

• DXF

Professional

Professional provides access to several add-on modules that further extend the analysis capability of
Lifecycle Visualization while also enabling users to author content.

Features provided by Professional include:

• All the functionality provided by Standard

• Advanced navigation features

• Ability to create and save alternate hierarchies

• 3D transformation, manipulators, and part manipulation mode

• Honor constraints in session files or PLM XML

• Advanced cross section functionality

• Comparing similar 3D models

• User-defined 3D coordinate systems

• Quick Color tool

• True Shading

• Advanced appearance tools

• Outline capture
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• Creating and managing callouts and symbols

• Creating and editing thrustlines

• Generating exploded views

• Creating and playing motion (.vfm) files

• Capturing movies

• CAE results viewing

• Viewing Visualization Illustration documents

• Report generation

• Stereo viewing

• Virtual Reality device support

• Ability to export JT, Nastran, Robface, and VRML files

• Ability to export .plmxml files

Professional supports the following optional modules:

• Visualization Illustration

• Concept Desktop

• Concept Showroom

• Variation Analysis

• Quality Producer (Windows only)

• ECAD Viewer

• Visual Reports

• Animation authoring

• .vfz collaboration file authoring

• ADAMS conversion (Windows only)

• STEP file export

• MetaVPDM

Professional supports the following optional file converters:

• IGES
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• STEP

• DXF

Mockup

A real-time digital prototyping solution, Mockup combines a wide range of features with a robust set of
dynamic analysis tools to help engineers identify defects in digital products at a much earlier stage
of the product design cycle.

Features provided by Mockup include:

• All the functionality provided by Professional

• Dynamic interference checking to find and display interference quickly during motion playback

• Matrix clearance analysis to perform complete analysis on large, 3D product databases

• Create and manage part constraints

• 3D grouping

• Filter queries

• Area and mass properties reports

• 3D alignment

• Volume clipping

• Hide obscuring geometry

• Color application

• Part editing

o B-Rep face reversing

o Re-tessellation

o Decimation

o Visibility simplification

o JtOptimize

Mockup supports the following optional modules:

• Visualization Illustration

• Concept Desktop

• Concept Showroom

• Variation Analysis
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• Quality Producer (Windows only)

• Jack

• ECAD Viewer

• Visual Reports

• .vfz collaboration file authoring

• ADAMS conversion (Windows only)

• STEP file export

• MetaVPDM

• Analysis

• Animation authoring

• Path planning

• ClearanceDB

Mockup supports the following optional file converters:

• IGES

• STEP

• DXF

Convert and Print

Convert and Print are flexible command-line conversion and print software utilities that augment the
power of the Lifecycle Visualization products. Both applications provide you with tools to convert and
print many file formats, resulting in consistency and efficiency.

The key advantage to Convert and Print is their capacity to integrate effectively both native and
external file format converters. By integrating the converters, you can convert original files directly into
a supported file format. You can also print these files directly into the format required by your printer.
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Chapter 3: Deprecated platform announcement

Siemens PLM Software will discontinue support for Teamcenter lifecycle visualization ClearanceDB
(client and proxy tiers) on all Sun platforms, starting with Teamcenter 12.x. This includes Clearance
Calculator (ClearanceExe), ClearanceDB Client (ClearanceDbClient), and ClearanceDB Proxy
(ClearanceDbProxyServer and ClearanceDbProxyClient). ClearanceDB Server tier support on Sun
will remain consistent with Teamcenter Server platforms.
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Chapter 4: What's new

What's new overview
This Teamcenter lifecycle visualization release includes the following new features and
enhancements. Descriptions are categorized by product level and optional module.

New features for Base

Highlight model views for selected PMI

When you are viewing a 3D model with PMI, you can find and display the model views that contain
selected PMI.

When you right-click the selected PMI, and choose Related Model Views, you can choose from
three options:

• Highlight in Tree

The model views containing the selected PMI are highlighted on the PMI page of the Project
Workspace.

• Find with Gallery

The model views containing the selected PMI are listed on the Model Views page of the Project
Workspace.

• Show View

The model view containing the selected PMI is displayed in the Viewing window. If the PMI is
contained in more than one model view, choose Show View again to cycle through the model
views.

Background geometry is not cross-sectioned

Parts that contain the property TcVis_Concept_Background_Geom on leaf components are now
considered part of the background or environment and do not have cross sections applied to them.

Sample background parts are included with the example files in your installation:
install_directory\Siemens\TeamcenterX\Visualization\Examples\Concept\Models\Environments.

Product views reflect structure changes

Product views are more robust to line-balancing structure changes performed in Manufacturing
Process Planner. Product views opened with Teamcenter lifecycle visualization update to reflect
structure changes for plant bill of process (BOP) lines that are moved with a cut-and-paste action at
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the level of consumed lines or higher. This enhancement applies to the original plant BOP as well as
any plant BOPs generated using the original plant BOP as a template.

New features for Standard

View properties of 4GD partitions

When you send 4GD data to the stand-alone viewer or the embedded Lifecycle Viewer, you can
now view the properties of the partition nodes.

New features for Professional

Immersive mode enhancements

The following enhancements are added for working with immersive devices:

• Conferencing with immersive devices is enhanced:

o Conference participants can collaborate and share cross section, measurement, and
freehand markup information in real time without changing leadership.

o An avatar appears for each conference participant, showing the head position and orientation.

o A new button in the immersive conference interface enables a conference participant to
become the conference leader.

o The conference leader is designated with a special icon.

• Tooltips are added to immersive mode to aid users in selecting various functionality.

• When in Attach/Release mode, you can use the dial pad or joystick to move the attached
objects closer or farther away.

When you move the attached part closer to its original position, a semi-transparent shape
appears to represent the part's original position. A tooltip guides you to place the part back in
its original position.

• Snapshot functionality in immersive mode is enhanced with a button in the viewfinder that
enables you to more easily add a snapshot. You click the button to add a snapshot. A preview of
the snapshot appears to confirm the snapshot was captured.

Also, snapshots are consistent between desktop and immersive modes.
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New features for Mockup

Path generation improvements

Path quality is improved, and path generation results are more predictable. In path planning, step size
is removed since uniformly segmented path results are no longer generated. Instead the generated
path result includes only the key points on the path required to guarantee the static clearance value is
satisfied for the entire path.

Since the new path can be a sporadic set of points, the Motion Playback player now includes an
option to choose either a time-based or a frame-based playback. The time-based setting allows the
new non-linear paths generated by path planning to be played back based on the length of the
path instead of the number of points on the path. This enhances motion playback in applications
such as dynamic clearance checks.

Clearance analysis enhancements for 4GD objects

Clearance analysis is enhanced with support of additional 4GD objects:

• Multiple subsets of clearance calculation subsets

You can load and visualize ClearanceDB results for 4GD worksets referencing multiple subsets,
or more precisely, 4GD subset definitions. The subsets of a workset can be subsets of a single
4GD product design or of multiple 4GD product designs. The subsets can be disjointed or they
can intersect.

The ClearanceDB results to be loaded can be based on ObjectType of Workset or on
ObjectType of ClearanceCalculationSubset.

Configure ObjectType in the Clearance.cfgglobal file and ModelID,
ClearanceCalculationName, and PartitionSchemes in the Clearance.cfgproduct
file.

Before loading ClearanceDB results, the viewer examines the content of the database. If workset
based results exist in the database they are loaded; otherwise the viewer attempts to load
clearance calculation subset(s) results. In general, a single ClearanceDB result can be loaded
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multiple times, at most once per a subset. A new column, Subset, is available to add to the
clearance results list to enable you to determine which subset a clearance result belongs to.

• Inferred Partition Attributes

You can now analyze clearance results for 4GD partitions. This includes the support of inferred
attributes for 4GD partitions in addition to the legacy support of product structure attributes.
Inferred attributes can be displayed in the Clearance Results window. They can also be part of
both client and server side clearance results filter definitions.

You must configure these settings:

o PartitionAttribute in the Clearance.cfgglobal file, similar to the Attribute setting.

o In Clearance Results Preferences:

On the General tab, use Show 4GD partition scheme legend to display the partition
scheme mapping as a legend within the Clearance Results window.

On the Columns tab, use Generate optional 4GD partition scheme columns to
choose whether to the generate 4GD partition attribute list for optional columns.

Clearance results preferences enhancements

The default display options for the Clearance Results Preferences dialog box are updated to
improve usability.

• Element 1 and 2 display:

o On the Element Display page, when Element1 or Element2 is selected, the Transparency
is set to 75 percent.

o Also on the Element Display page, Feature Edges is selected so that feature edges are on.

• Intersection volume display (the area where Element 1 and Element 2 intersect):

o On the Element Display page, when Intersection Volume is selected, the Transparency is
set to 100 percent (opaque).

o On the Analysis page, in the Intersection Volume section, Show is selected to automatically
display the intersection volume for penetrating element pairs by default.

• Contact and penetration point display:

o On the Analysis page, the Contact and Penetration Points values are changed:

■ The default size of the Most severe penetrations and Selected contacts and
penetrations is changed from 3 to 4.

■ The default color of the All Contacts color well is changed to cyan.

■ The default color of the Less severe penetrations color well is changed to orange.

o Also on the Analysis page, the default setting for Displayed Regions is changed to All,
so you see all regions of contact/penetration for each pair.
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• Penetration vector display:

On the Result page, in the Penetration Vector section, Show is selected to display an arrow
to visually represent the depth of a clearance penetration. The default color has been changed
from red to green.

Enhancements to clearance element pair analysis

The interfaces used during the analysis of clearance of element pairs are updated for better usability.

• In previous releases, bounding boxes around contact/penetration points were always aligned to
the XYZ coordinate axes. Now contact/penetration points have a best-fit bounding box for better
visualization of the points within each contact/penetration region.

• On the Analysis tab of Clearance Results Preferences, Show for Intersection Volume is now
activated by default. When you enter element pair analysis mode, if Display only is selected,
Advanced Transparency is activated automatically. When you leave element analysis mode,
the original value for Advanced Transparency is restored. Leaving element pair analysis mode
is defined as one of these four actions:

o You disable clearance analysis.

o You close the Clearance Results window.

o You choose Clear Analysis.

o You close the open view and/or document.

• You can display a summary box showing the element pair result number and the region of
contact or penetration for the result shown in the Viewing window. A new preference, Onscreen
Analysis Summary, enables you to display the summary and select its font size. This summary
makes it easier to see your place in the results list without having the Clearance Navigation &
Analysis dialog box open.

• The Clearance Navigation & Analysis dialog box, used when analyzing the clearance of
element pairs, is reorganized and is updated with new features.

o New Zoom/Seek options are added to enable you to adjust the view of the displayed result in
the Viewing window.
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o The Create distance lines option is now Show to be more consistent with other annotation
types, and it is moved to the No Distance Lines Study section.

o The Actions section consolidates several different commands in a single location.
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• A new preference provides you with more control over camera settings when navigating results in
the Clearance Navigation & Analysis dialog box. The Only apply when requested option on
the Result tab of Clearance Results Preferences controls the camera settings as follows:

When this option is selected:

The camera settings are not automatically applied during result navigation, but they are when
you click Zoom to Preference in the Clearance Navigation & Analysis dialog box (or press
Ctrl and the + key). This allows you to browse the clearance issues at the element pair level
and only zoom/seek to the current region when needed.

When this option is not selected:

The camera settings are automatically applied during results navigation as usual.

• The Open Clearance Navigation Dialog button is added to the Clearance Results toolbar
to open the Clearance Navigation & Analysis dialog box.

• The Column Filters in the Clearance results list are activated by default.

• The Clearance Toolbox is displayed by default.

New features for Variation Analysis

Point Measurement Generator enhancements

The Point Measurement Generator command has the following new options and enhancement:

(1) 3D—Selects all the points in the parts you select by drawing a rectangle around them in
the Viewing window.

(2) Reset Spec Limits—Clears all the existing specification limits applied to the selected
points in the point selection list.

(3) Apply Direction Vector —Lets you specify a direction vector without affecting the
specification limits.

• (4) The default LSL and USL specification limits are no longer set.
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Optionally specifying datum gage diameter

You can now specify a datum reference frame gage diameter when the value cannot be determined
during the initialization of validation or simulation.
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This occurs occasionally when the datum gage diameter used during feature fabrication cannot be
calculated.

For example, in the following image, the Hole X feature references datum reference frame [C|B(M)].

Because a 0.2 perpendicularity tolerance is applied to Datum C, the gage size of Datum B when
applied at Maximum Material Condition (MMC) for the fabrication of feature Hole X is unknown.

(1) Hole X

(2) [C|B(M)]

(3) Datum C

(4) Datum B

In this case, during the initialization of validation or simulation, the following message is displayed:

Part: Part

Datum reference frame gage diameters cannot be determined for:

[C|B(M)]

In order to specify a specific gage diameter, use the notes field in the part properties dialog (also see online help)

Custom!

[C|B(M)] followed by diameter_1 diameter_2

To accurately fabricate the Hole X feature using an appropriate gage diameter, the user can specify a
gage diameter for Datum B on the Notes tab of the Part Properties dialog box.
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The syntax for specifying the gage size is Custom [C|B(M)] 8.0, where 8.0 is the desired gage
diameter for Datum B.

If the gage diameter is not explicitly specified as 8.0, then the datum reference frame gage diameter
of 7.89 (the virtual condition of 8.0 - 0.01 - 0.1) is used.

For a video on how to calculate and specify the gage diameter for cases when the software cannot
determine the value used during feature fabrication, see the Unresolved DRF Gage Size article
in the Tecnomatix Knowledge Base.

Automated DPV Lite data linking

The Link Feature Tolerance To DPVLite Attribute command is enhanced with Automated
Attribute Mapping options, so you can automatically link and map Variation Analysis features
to DPV Lite attributes.

You can only link each Variation Analysis feature to a single DPV Lite attribute.

You can select from the following methods of linking; however, once linked, the matched link cannot
be overridden or relinked by another method:

• Manual Match—Lets you manually select the Variation Analysis feature and DPV Lite attribute
to link.

• Match by Name—Matches a Variation Analysis point feature to a DPV Lite attribute whose
name matches the name you input.

Note

The matching is not case-sensitive and the name you input must match the DPV
Lite attribute name.

• Match by Distance—Matches a Variation Analysis point feature to the closest DPV Lite attribute
within the distance you specify.
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Note

In the case of multiple results, the closest attribute by distance is used.

Automated feature naming

Use the new Naming Process Document preference to define a naming convention for the default
names of features created in a part.

You can enter feature-naming syntax to define the naming conventions for features and sub-feature
points.

You can apply the following properties in a feature-naming string:

• Feature type

• Custom text

• Parent name, including which consecutive characters to include or omit

• Counter

For example, the feature string <Type_D>"–––"<Parent5-8>"___"<Counter01> for a parent part
named P34H9845 results in a hole feature named Hole—9845___01.
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Supported platforms
For information about the platforms on which you can run Teamcenter lifecycle
visualization, see the Hardware and Software Certifications page on GTAC:
https://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.

Supported locales
The Lifecycle Visualization application and help are localized for the following languages:

• Chinese (Simplified and Traditional)
• Czech
• French
• German
• Italian
• Japanese
• Korean
• Polish
• Portuguese (Brazil)
• Spanish
• Russian

Some optional modules are available in English versions only, including:

• ClearanceDB
• Convert and Print
• Jack
• Quality Producer
• Variation Analysis

Note

• A separate installer is required for each language version of the help.

• Because of operating system limitations, Teamcenter lifecycle visualization does
not support non-ASCII characters, including 8-bit accented Western European and
multi-byte characters, in file names.
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Chapter 6: System requirements

General system requirements
Performance is directly related to system processor speed, RAM, and your video card. Although
Lifecycle Visualization will run if your system meets the minimum requirements described in this
section, your machine should be considerably more powerful for you to get the full benefit of the
visualization features.

Minimum required system

For 3D models, 2D images, and ECAD images, your system should have a 1 GHz or better processor,
1 GB RAM, 2 GB of virtual memory, and a supported graphics card with 128 MB of dedicated video
RAM and support for OpenGL 2.1 or greater.

Minimum recommended system

For 3D models, 2D images, and ECAD images, your system should have a 2 GHz or better 64-bit
processor, 4 GB RAM, 6 GB virtual memory, and a supported graphics card with 256 MB of dedicated
video RAM and support for OpenGL 3.2 or greater. For more information on which graphics adapters
are supported, see Graphics hardware requirements.

Note

http://www.plm.automation.siemens.com/locale/support/gtac/certifications.shtml

These are only recommendations. For information on officially supported workstations,
video cards, and drivers, see the Hardware and Software Certifications page on GTAC:
https://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.

License server requirements
Lifecycle Visualization products use the Siemens PLM Software Common Licensing Server for
served licenses.

For information about Siemens PLM Software that supports Teamcenter 11.6
lifecycle visualization, see the Hardware and Software Certifications page on GTAC:
https://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.

Teamcenter community collaboration visual conferencing
requirements
To use Teamcenter 11.6 lifecycle visualization with Teamcenter community collaboration visual
conferencing you must have Teamcenter community collaboration conference server 11.1 or higher
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Teamcenter community collaboration visual conferencing is not supported on older conferencing
servers.

Graphics hardware requirements
Supported graphics adapters for use with Teamcenter lifecycle visualization include the following
professional 3D graphics adapters with their professional drivers:

Manufacturer Models
NVIDIA Quadro, QuadroFX, Grid
AMD FireGL, FirePro
Intel HD 4600 and newer

For full confidence that all of the advanced features of Teamcenter lifecycle visualization are
displayed, including effects such as high-quality transparency, shadows, mirrors, CAE analysis
results, intersection volumes, and other features requiring advanced graphics capabilities, use a
certified system. Siemens PLM Software and our OEM partners rigorously test specific graphics
adapters and drivers on a select set of workstations. Graphic adapters and drivers that pass are
certified for use with a particular version of Teamcenter lifecycle visualization.

For information about certified systems, see the Hardware and Software Certifications page on GTAC
(http://www.plm.automation.siemens.com/locale/support/gtac/certifications.shtml) and follow the
link to Hardware (Graphics Card) Certifications.

Note

Starting with Lifecycle Visualization version 10.1, if your graphics card supports OpenGL
3.2 or later, Lifecycle Visualization uses advanced OpenGL features to improve 3D
rendering performance, including making use of memory on the graphics card. If you work
with large models, we recommend graphics cards with 2GB or 4GB of GPU memory, or
more. While exact memory requirements are highly situation specific, a rough guideline
for required graphics card memory is 1 GB of graphics memory for every 2 GB of loaded
geometry data.

Consumer line and 2D graphics adapters

We do not recommend consumer lines of graphics adapters. These adapters and drivers are
designed for playing games and emphasize frame rate over correctness. Drivers for consumer
graphics are serviced by driver development and ISV partner teams separate from those for
professional 3D adapters.

However, even these video adapters, if you have the most current graphics driver, usually work at a
reduced effects level with Lifecycle Visualization. It may be necessary to reduce the performance
settings.
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Note

When the OpenGL level of a graphics adapter is not capable of rendering an advanced
visualization effect, the visual effect is silently omitted.

Some graphics adapters, especially those manufactured before 2008, contain issues that
prevent Lifecycle Visualization from displaying certain specific features properly, regardless
of their OpenGL support level claims.

Resolving graphics adapter issues

You are encouraged to report graphics display problems found on recommended and certified
hardware to http://www.siemens.com/gtac. We attempt to reproduce the problem. If a reproducible
problem is determined to lie within Lifecycle Visualization software, we fix it directly; if a problem is
found with the graphics driver, we work with the graphics vendor to isolate the issue and assist
them as necessary to produce a driver patch.

We do not attempt to resolve problems that cannot be reproduced on recommended or certified
hardware; we advise you to take such issues directly to the graphics adapter manufacturer.

Help requirements
To run the Teamcenter lifecycle visualization help, the following requirements must be met:

• Windows:

o Internet Explorer – 8 or higher

o Firefox – 16 or higher

o Chrome – latest release

• Linux:

o Firefox latest release

• Mac OS X:

o Safari – latest version

o Chrome – latest version

• The Siemens PLM Documentation Server requires a supported 64-bit Java Runtime Environment
(JRE) on the PLM Documentation Server host. The PLM Documentation Server does not
support 32-bit Java.

Make sure a supported 64-bit JRE is installed on your PLM Documentation Server host.

• To watch videos and simulations, the Adobe Flash Player version 10 or later is required. You
can download the latest version of the player from this location:

http://get.adobe.com/flashplayer/
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• Some portions of the help are in the PDF format, which requires Adobe Acrobat Reader (any
version). You can download the reader from this location:

http://get.adobe.com/reader/

Note

The help files are no longer packaged with the Teamcenter lifecycle visualization installer.
To install the help locally, you must install the Siemens PLM Documentation Server and
the Teamcenter lifecycle visualization help, which are installations separate from the
installation of Teamcenter lifecycle visualization. You must also set the port and server
for help access for clients during the product installation or after the product installation.
A separate installer is available for each language version of the help. Alternatively, you
may access the help from the Siemens PLM Software Doc Center site, which you are
directed to when you select the Help commands in the software after you choose not to
install help during the software installation.

Firefox caveats

Firefox recommends that users update to the latest version for security issues surrounding Java.
They do not recommend using older versions of Firefox due to these issues. See the following
for more information:

http://support.mozilla.org/en-US/kb/latest-firefox-issues

Chrome caveats

By default, Chrome does not launch local files (e.g. file:///). To enable this, users have to start
Chrome from the command line with the –allow-file-access-from-files switch. One source for how to
do this is: http://www.askyb.com/chrome/open-local-file-in-google-chrome/

PDF requirements
To view, mark up, and print PDF and Postscript files on Mac and Linux systems, you must install
and use Ghostscript.

1. You can navigate to the following Web site to download and install the Ghostscript software:

https://download.industrysoftware.automation.siemens.com/open-source/ghostscript

2. After installing Ghostscript on Mac or Linux systems, add the following to your vvcp.darwin.cfg
or vvcp.linux.cfg file in the <installation_directory>/app_defaults/ directory:

*PSPath: <path to the ‘gs’ executable>

For example, add *PSPath: /usr/apps/gs864/bin/gs.

Ghostscript is also required to work with Postscript files on Windows systems. You can download the
Windows version from the site shown above.
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Tip

To configure Ghostscript to use system fonts on Windows, install Ghostscript before you
install Lifecycle Visualization.

IDW requirements
To work with Autodesk Inventor .idw 2D files, you must have one of the following:

• Autodesk Inventor

• Autodesk Inventor View, a freely distributed application available from Autodesk

• Design Tracking, a freely distributed utility available from Autodesk

Note

• Support for Autodesk Inventor .idw files depends on the version of the Autodesk
Inventor, Autodesk Inventor View, or Design Tracking that you have installed. For
example, if you have Design Tracking 7, then Inventor 5.3 through 7 files are supported.
If you have Autodesk Inventor View 11, then Inventor 5.3 through 11 files are supported.

• Autodesk Inventor .idw files prior to version 5.3 are not supported.

ADAMS conversion requirements
The ADAMS conversion feature, which converts RES files to the VFM motion file format, requires
the Professional or Mockup product configuration, as well as an additional license. It is supported
on Windows only.

Visualization Illustration requirements
To install Visualization Illustration, when you install Teamcenter lifecycle visualization by right-clicking
the setup.exe, you must select Run as an Administrator. This is necessary to register
VisVisioHostApp in Windows.

Visualization Illustration is supported on Windows only (Windows 7 or Windows 10), and requires
one of the following:

• Visio 2010 with Service Pack 2, either the 32-bit or 64-bit version

• Visio 2013 or 2016 with the latest patch, either the 32-bit or 64-bit version

Authoring Visio-based work instructions in Teamcenter Manufacturing is supported only with 64-bit
Visio 2010.

Standard, Professional and Premium editions of Visio are supported.
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Convert and Print requirements
• The Convert and Print Office Automation feature requires Microsoft .NET Framework. Version

4.5.x is recommended.

You can download Microsoft .NET Framework for your version of Windows from
http://www.microsoft.com/en-us/download/

• To view, convert, and print Microsoft Office files, you must have Microsoft Office installed.

ClearanceDB requirements
For information about the requirements for ClearanceDB, see ClearanceDB Administration in the
Teamcenter lifecycle visualization help.

Interoperability with other software
For information about Siemens PLM Software that supports Teamcenter 11.6
lifecycle visualization, see the Hardware and Software Certifications page on GTAC:
https://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.

Teamcenter client communication system (TCCS) requirements
The Teamcenter client communication system (TCCS) manages communication and file transfers
between Teamcenter clients and servers. TCCS contains the Teamcenter Server Proxy (TSP)
application which manages HTTP/S communication with a Teamcenter server and provides support
for forward proxy, reverse proxy, and Kerberos authentication. TCCS also contains the FMS client
cache (FCC), which uploads files from your workstation to a Teamcenter volume and also downloads
requested files from the volume to your workstation. The Teamcenter lifecycle visualization integration
with Teamcenter requires an FCC to transfer volume data between Teamcenter and the viewer.

TCCS is normally installed with the Teamcenter rich client. If the Teamcenter rich client is
installed on your machine, most likely no additional installation steps are necessary. If you do
not have the Teamcenter rich client installed, but you need to transfer volume data between
Teamcenter and the viewer, you can you can download the TCCS installer from the GTAC site
http://www.siemens.com/plm/support. For more information, see the Lifecycle Visualization
Installation guide.

Note

An FCC is required for Teamcenter 8 onwards. Although an FCC is not required for
Teamcenter 2007, it is recommended.

For information on installing TCCS with the Teamcenter rich client, refer to Windows Clients
Installation, Linux Clients Installation, or Macintosh Clients Installation within the Teamcenter
documentation.
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Chapter 7: Resolved Problem Reports

Customer problem reports (PRs) resolved for Teamcenter 11.6 lifecycle visualization include:

PR Product Category Summary

3056942 VISVIEW 3D_MEASUREMENT 3D associative measurements not working on
certain data.

9166015 VISVIEW 3D_MEASUREMENT Single 3D measurment ignores diameter
setting in 3D Measurement Preferences.

9179459 VISVIEW 3D_MEASUREMENT VisDispMeasurementEntity MeasureDistance
shows null result.

9181303 VISVIEW 3D_MEASUREMENT Measurement automation API returns NULL
instead of measurement entity.

9200609 VISVIEW 3D_MEASUREMENT Aligning a section with measurement is not
working with leaf structure.

9212238 VISVIEW 3D_MEASUREMENT Changing measurement preferences from
Radius to Diameter does not work.

9224996 VISVIEW 3D_MEASUREMENT In 3D measurement, the Diameter preference
switches to Radius after a measurement.

9093296 VISVIEW 3D_PSLOADER Fetching FMS tickets while double-clicking on
parts.

9052551 VISVIEW 3D_VIEW_CONTROL Zooming issues (data specific).

7822801 VISVIEW APPEARANCES Measurement not showing graphics view when
user selects Show light option.

9239117 VISVIEW APPEARANCES Korean language format setting causes TcVis
to stop responding.

9271257 VISVIEW APPEARANCES Viewer stops responding when loading
appearance information of JT.

8390370 VISVIEW CLEARANCE Missing documentation for custom reports for
clearance results.

9025001 VISVIEW CLEARANCE Misleading German translation for new
Clearance Distance Lines Filter.

9161076 VISVIEW CLEARANCE Clearance Report has incorrect information
with additional fields.

9182574 VISVIEW CLEARANCE Matrix Clearance takes longer after data is
loaded and unloaded.

9195180 VISVIEW CLEARANCE Matrix group-to-group clearance no longer
possible after UI change in 11.x.

9112166 VISVIEW CROSS_SECTION3D 3D Section: Align Plane > To Curve At Point
doesn't work as expected.

9215897 VISVIEW CROSS_SECTION3D Viewer stops responding after aligning a
section plane.

9222105 VISVIEW DIRECTMODEL WF and curvesets are not visible behind
transparent parts.

9184621 VISVIEW FRAMEWORK_PC Viewer dialog boxes accept non-numeric
characters in numeric input fields.

9196865 VISVIEW INSPECTOR PMI Fidelity in JT Inspector: wrong nominal
angle units for PMI Angular Dim.
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PR Product Category Summary

9196890 VISVIEW INSPECTOR PMI Validity in JT Inspector: <unknown(78)>
error for Lightweight section view.

9198156 VISVIEW MODELVIEW_GALRY Tree view of Model View tab displays MVStyle
elements.

9208863 VISVIEW MODELVIEW_GALRY Properties of selected PMI is disabled if
selecting from Model View tab.

9200711 VISVIEW PARASOLID_INTEG In 3D Measurement, a point on edge
measurement with section lines is wrong.

9078612 VISVIEW PATH_EXTRACTION Adding a key position for path planning will not
populate in the key positions.

9153994 VISVIEW PATH_EXTRACTION Path planning generation fails with collision
when wireframe is turned on.

7823147 VISVIEW PMI PMI Ballon Note: NX component is highlighted;
in TcVis, only 1 face is highlighted.

7896365 VISVIEW PMI By selecting a PMI label the wrong face gets
highlighted.

9088038 VISVIEW PMI Model View of translated JT shows PMIs that
are not content of the Model View.

9099489 VISVIEW PMI PMI outline gets zoomed when being
moved/dragged.

9187474 VISVIEW PMI PMI highlighting Solid Body problem.

9057061 VISVIEW PUBLISH Shaded Asset Capture function isn't displaying
the same image as the 3D part.

9133337 VISVIEW SESSION JT2Go 11.4 Issue Reading VFZ File.

9233448 VISVIEW SESSION Not able to perform Save Session As for
plmxml files.

9239083 VISVIEW SESSION Save session causes TcVis to stop responding.

9041762 VISVIEW VISUAL_REPORT Results are incorrect when setting Japanese
as a condition of visual report.

9194830 VISVIEW VR_DEVICES VRPN joystick issue.

9252899 VISVIEW VR_DEVICES HTC-Vive camera not restored from snapshot
as expected.

9219250 VISVIEW COMMAND_LINE_OP prepare.exe -PDF results in PDF files with
missing characters i and l.

9277717 VISVIEW EXTERNAL_APPS PDFControl system stamp configuration not
stamping correctly.

9248962 VISVIEW SECURITY_RISK 7-Zip library upgrade recommendation.

3056676 VISVIEW VISVSA Process tree selection not working with
3DSection.

3057421 VISVIEW VISVSA Flex Assembly Springback incorrect result
unless Loadsteps defined in order.

3057422 VISVIEW VISVSA Flex Assembly Springback - More points than
there are force/moment IDs.

7620664 VISVIEW VISVSA Highlighted part in Project Workspace stops
working in VA.

7974070 VISVIEW VISVSA VSA: Missing highlight in model tree.

8388971 VISVIEW VISVSA Variation Analysis - Not all contributors are
included in the analysis.

8549284 VISVIEW VISVSA Plane features are not created as intended.

8821927 VISVIEW VISVSA Part node not highlighting in tree.
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PR Product Category Summary

9016528 VISVSA VISVSA VSA batch mode: output of measurement type
calculation in results documentation.

9016625 VISVSA VISVSA Using VSA in batch mode, the process report
sigma range is not considered.

9022414 VISVSA VISVSA Derive from feature geometry button not
working on ribbon bar.

9045772 VISVSA VISVSA VSA parts or features not highlighting in
Project Workspace window.

9129784 VISVSA VISVSA Data terminated if you do not select a type in
Flex Assembly Operation.

9144211 VISVSA VISVSA Feature creation issue.

9200119 VISVSA VISVSA Zone shift values are invalid for pdo text import.

9233519 VISVSA VISVSA Feature list empty when attempting to link part
to DPV Lite data.

9263921 VISVSA VISVSA
The sum of GRAVITY analysis and SPOT
analysis does not result in analysis result of
GRAVITY+SPOT.

9264479 VISVSA VISVSA pdo file stops responding when trying to run
a simulation.

9269927 VISVSA VISVSA Kinematic Assembly Operation not working.

9277968 VISVSA VISVSA TcVis-VA Measurement MathEq crashes.
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Chapter 8: Issues and workarounds

Hardware acceleration when running in Ribbon mode

Problem On systems that contain both discrete and integrated graphics cards,
Teamcenter lifecycle visualization may only utilize the integrated graphics card
when the Ribbon bar interface is enabled.

Workaround For discrete graphics, to enable high performance, you must set the
VisView_NG.exe program to run in high performance mode. On Nvidia graphics
cards, you can do this by assigning the high performance NVIDIA processer to
the VisView_NG.exe program. You can set this in Manage 3D Settings in the
NVIDIA Control Panel.

Installation options obscured in older Mac OSX versions

Problem When using some older versions of Mac OSX, during installation, the license
server port and help server port options are obscured. This is not an issue if
your license server and help server were configured using default settings,
because the installer will use the default port 2800, which will match the server
configuration.

Workaround Either update your system to OSX 10.13, or follow these steps:

License port:

1. Navigate to /Visualization/license in the installation directory.

2. Open the license.dat file with a text editor.

3. Follow the instructions in the license.dat file to replace the 2800 port value
with the desired port.

Help port:

1. Navigate to /Visualization/bin in the installation directory.

2. Type this command: update_help_path <docServerName> <docServerPort>

Text not selectable in PDFs from Visualization Illustration

Problem Text is not selectable in PDFs produced from Visualization Illustration using
Visio 2013 or earlier. Visualization Illustration produces PDFs with raster quality
images and thus text is not selectable.

Workaround Install the update for Office 2013, KB4018331, dated October 2, 2018, from
https://support.microsoft.com.
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Cross section issue in virtual reality conferences with previous release participants

Problem A virtual reality conference participant using the desktop interface in a release
prior to 11.6/12.1 may not correctly send cross sections to participants using
11.6/12.1 or later. This issue occurs when the newer release participant has
different selections than the older release desktop participant when the desktop
participant creates a section.

Workaround None

UNIX session ends when loading JT data

Problem When working in UNIX and loading JT data in an embedded viewer in
Teamcenter, the session ends.

Workaround Use the latest version of the NVIDIA driver.

CAE legend annotation does not appear properly

Problem When exporting CAE data into the JT format using NX12, if you choose the old
style JT CAE format (prior to TcVis 11.0), the legend annotation does not appear
properly when opening the JT file in TcVis 11.0 or later.

Workaround Choose the new style JT CAE format (TcVis 11.0 and later) when exporting CAE
data into JT in NX12.

Parts not positioned correctly for model views in session packages

Problem When you load session packages that have model views applied, upon reload
of the session package, parts may not be positioned correctly for model views
that enforce part transforms.

Workaround Use Reset Part Position and reapply the model view.

Thumbnails of model views not captured

Problem When you load a session file that contains model view palettes, and a session
file containing a model view palette in Teamcenter is saved using the static
configuration, the thumbnails of the model views on the palettes are not
captured. You may see ModelView palette entries that are empty.

Workaround Save the session as dynamic references.

NX PRT loading support

Problem Teamcenter Visualization supports NX12 PRT loading on Windows only.

Workaround For other platforms, Teamcenter Visualization supports up to NX11.
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Cannot rotate grouped shapes from a stencil list

Problem Due to a Visio 2013 and 2016 issue, you cannot rotate grouped shapes that
are added from a stencil list.

Workaround None

Cell borders missing in graphical reports

Problem Due to a Visio issue, cell border lines are missing in tables in DPV graphical
reports when printed in PDF format.

Workaround None

Some charts and tables missing in graphical reports

Problem Some charts and tables are missing in printed DPV graphical reports when
printed in PDF format. This happens when the assets are overlaid over another
in the Visio document.

Workaround In Print Setup on the Advanced tab, select Print as image.

Saving graphical reports as text doesn't save chart and table text

Problem Due to a Visio and/or Acrobat issue, chart and table text is missing in DPV
graphical reports when the PDF is saved as text.

Workaround In the open PDF file, select all text and copy it in a text editor.

- or -

Use the feature in PDF-XChange Editor to convert the PDF to text.

Visualization Illustration stops responding when working with gradients on shapes

Problem Teamcenter Visualization stops responding when you work with the Shapes
context menu and modify the gradient.

Workaround Update Visio 2013/2016 to the latest patch from https://support.microsoft.com.

Values in Variation Analysis not retained or are corrupted

Problem Values keyed-in in Variation Analysis edit boxes are not retained or are
corrupted.

Workaround Install the Microsoft windows patch KB4041681.
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JT Utilities Integration with Teamcenter is obsolete

Problem The integration of JT Utilities with Teamcenter is removed from Teamcenter 11.4
and later versions. You may still use JT Utilities as a standalone tool or as an
integration tool with any product where this utility is properly configured and
integrated. Standalone JT Utilities is available for download from the GTAC
download site, under Teamcenter Visualization→JT Translators→PLM Vis:
https://download.industrysoftware.automation.siemens.com/

Workaround Siemens PLM Software recommends opening JT assemblies with the Lifecycle
Viewer or the embedded viewers in Teamcenter.

Generating a DPV template from a technical portfolio is slow

Problem Generating a DPV template from a technical portfolio is slow.

Workaround If Visio is used in VisAutomationServer for updating the DPV templates, set the
environment variable TCVIS_VISAUTOMATIONSERVER_VISIO to true on the
client machine where DPV templates are created.

Text not selectable in Visualization Illustration raster quality images

Problem In Visio 2013 or earlier, Visualization Illustration produces raster quality images
and thus text is not selectable.

Workaround Update Visio 2013 to the latest patch from https://support.microsoft.com.

Shapes from File menu is not supported with Office 365

Problem Visualization Illustration with the Office 365 version of Visio does not support the
Shapes option from the File menu.

Workaround Use the ribbon interface to choose Home tab→Stencil group→Shapes.

If shapes do not appear, open shape stencils from Visio 2016 once, close Visio,
and then start Teamcenter Visualization.

Error when opening HTML file published from a technical portfolio

Problem Due to added Java security restrictions, opening an HTML file published from
a technical portfolio may cause an error message.

Workaround Add the local folder where the HTML file is stored to the Exception Site List in
the Java Control Panel, as file:\\\D:/mydir/

Styles menu in Visualization Illustration causes program to stop responding

Problem The program stops responding when you work with the Styles context menu,
which is available when you select a 3D geometry asset or a shape in an
illustration.
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Workaround For formatting, from the Application toolbar, choose Menu →Format→Text,
Line, or Fill.

Help not compatible with older Documentation Server versions

Problem The Teamcenter 11.6 lifecycle visualization help is not compatible with versions
1.0 and 2.0 of the Siemens PLM Documentation Server.

Workaround Install the latest version of the Siemens PLM Documentation Server, available
on GTAC.

Not responding message appears during clearance analysis

Problem When you perform a clearance analysis in which the part pair analysis takes
several minutes, when you click in the main window, the message Application

not responding appears.

Workaround Click Wait for the program to respond, and the calculation will finish.

JT-STEP Bi-Directional Translator support issue

Problem The integration to JT-STEP Bi-Directional Translator does not support
the configuration control writeWhichFiles for a combination of values
AP242XML,JTPARTS in interactive and command line mode.

Workaround None

Measurement operation navigation buttons not functional in Variation Analysis

Problem The measurement operation navigation buttons are not functional if there is a
general surface feature that does not contain a sub-feature point associated with
a minimum feature clearance measurement operation.

Workaround Add at least one sub-feature point to the general surface feature.

Thrustline attached with a leaf component not repositioned correctly

Problem Thrustline attached with a leaf component may not be repositioned correctly
upon load if the position of the leaf components parent is changed due to new
revision.

Workaround None

Save not deactivated when technical illustration with file is saved

Problem If a file is inserted into a technical illustration, and the technical illustration is
saved, the Save button is not deactivated.

Workaround Close the technical illustration and click Yes when the message appears, Do you

want to Save changes to the file?
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Mismatch between outline geometry and shaded image

Problem When a 3D geometry asset is created without enabling page extents using the
Shaded with Outline option, and then asset is shown both in Illustration with
the Show Shaded with Outline option, a mismatch may occur between the
outline geometry and the shaded image.

Workaround Create 3D geometry assets with page extents enabled. If this issue occurs with
existing 3D geometry assets created without page extents, update the asset.

Loading a file from Teamcenter may fail if SSO is enabled

Problem When loading a file from a Teamcenter server to Teamcenter lifecycle
visualization running in a cluster system, if the server is configured with single
sign-on (SSO), the viewer running on the secondary system may fail to load
the data.

Workaround Teamcenter lifecycle visualization running on the secondary system may have
different environment variable settings as the one running on the primary
system. Do the following:

1. Create a text file, for example:

C:\tcvis_cluster_user_env_vars.txt

2. Set the system environment variable to point to the file, for example:

TCVIS_CLUSTER_USER_ENV_VARS=C:\tcvis_cluster_user_env_vars.txt

3. Identify the following environment variables used by Teamcenter lifecycle
visualization running on the primary machine:

APPDATA

USERPROFILE

USERNAME

4. Add the information to text file. For example:

APPDATA=C:\Users\PV\AppData\Roaming

USERPROFILE=C:\Users\YourUserName

USERNAME=YourUserName

5. Restart the secondary system.
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IPv6 for sockets

Problem The rich client embedded viewer does not support IPv6 for sockets. In this
instance, the viewer will attempt to force an IPv4 connection.

Workaround If using IPv6, ensure that IPv4 sockets are still enabled.

VBScript in Internet Explorer

Problem Internet Explorer support for VBScript has changed. The changes may impact
existing customer processes and deployments.

Workaround For details, refer to the information, VBScript in Internet Explorer, located in
this file in the installation Examples folder: Automation\Documentation
\ref_files\vbscript.htm

AutoCorrect options do not appear in Visualization Illustration

Problem When you use 64-bit Visio, the AutoCorrect options are not available. These
options are available from the Application toolbar when using 32-bit Visio:

• Menu→Tools→Options→Proofing→ AutoCorrect Options

• Menu→Tools→Auto Correct Options

Workaround Open Visio, and set the options using Tools→Options→Proofing→
AutoCorrect Options.

Dotted line appears in SVG file in technical illustration

Problem When you open an SVG file in Visualization Illustration, a dotted line may appear.

Workaround The line represents a page break and can be ignored. It does not appear in
printed or PDF output.

Linux embedded viewer dialog boxes appear behind the rich client window

Problem On Linux, embedded viewer dialog boxes may appear behind the main rich
client application window.

Workaround Use Gnome Window Manager. Most other Linux window managers do not work
correctly.

UI text does not display correctly for non-English locales on Linux

Problem Teamcenter lifecycle visualization interface text does not display correctly for
non-English locales on Linux.
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Workaround You must specify the language at the login screen to ensure the X Server loads
the correct fonts.

If the Font Creating Failed error appears, refer to the workaround below for the
Missing UI text on Linux issue.

Error when converting a DWG file with an embedded OLE object to PDF

Problem An error message appears when you attempt to convert a DWG file with an
embedded OLE object to PDF.

Workaround Disable macros and change resource settings:

1. In Excel, choose File→Options.

2. In the Excel Options dialog box, choose Trust Center.

3. In the Microsoft Excel Trust Center section, click Trust Center Settings.

4. Choose Macro Settings.

5. Select Disable all macros without notification.

6. You may need to set the following resource settings in the vvcp.ini file.
These settings require less memory when converting the file.

• DwgOLERasterQuality=0

• DxfOLERasterQuality=0

Some CGM files generated by Catia V5 fail to display the image

Problem Some CGM files generated by Catia V5 with embedded raster data fail to display
the image when loaded into Teamcenter lifecycle visualization. This is because
some CGM data generated by Catia V5 can be invalid based on the CGM
specification. The invalid data may not impact the rendering of the image, but
any found error can cancel the processing of the image.

Workaround If the CGM specification check is overridden, the image may still
display properly. To enable the override, while Teamcenter lifecycle
visualization is not running, create an environment variable named
TCVIS_IGNORE_CGM_RASTER_ERROR, and set it to any value. If any
problems loading CGM files are still present, disable the override by deleting the
TCVIS_IGNORE_CGM_RASTER_ERROR environment variable and restarting
Teamcenter lifecycle visualization.

No connection to hardware devices when immersive mode is activated

Problem When the immersive mode is activated,Teamcenter lifecycle visualization does
not connect to hardware devices.
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Workaround In the ImmersiveConfig.xml file, set <Auto_Activate name=""/> to a value of the
corresponding hardware device server name.

For example, to connect to a VRPN server, set the value as:

<Auto_Activate name="VRPN"/>

Available options for the hardware device server names are:

TrackD

InterSense

VRPN

If you are using ZSpace, Oculus Rift, or HTC Vive, use the corresponding
configuration file.

Animations created with Capture Walk not saved correctly

Problem Animations created with the Capture Walk option under Tracking Camera action
are not saved correctly in Tc Vis 11.1.1. Such animation data will not load
correctly in later TcVis versions.

Workaround Any Animation data created with the tracking camera action in TcVis 11.1.1
must be recreated in later versions.

Fast Mode and Manual Update options in 3D Section are disabled

Problem The Fast Mode option in the cross section preferences and the Manual Update
menu item and toolbar option are disabled.

Workaround None.

CAE data does not display properly on Linux and OS X

Problem The CAE data does not display properly on Linux and OS X.

Workaround None. The CAE visualization functionality introduced in Teamcenter Visualization
11.1 is not fully supported by the graphics card drivers currently available for
Linux and OS X.

Missing CAE units in CAE Viewing

Problem All the CAE units except Millimeters are displayed as Unknown in CAE Viewing.

Workaround None. The CAE units in CAE Viewing are not supported in Teamcenter
Visualization 11.1.
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Multiple clipped cross sections with capping do not display correctly

Problem If you create multiple clipped cross sections with capping enabled, the resulting
view may render incorrectly. It may look as if you can see through the capped
sections and see the backs of the other capped sections.

Workaround None

Missing UI text on Linux

Problem On Linux systems running in one of the UTF-8 locales (en_US.UTF-8), text
may be missing from the Teamcenter lifecycle visualization user interface. For
example, text may be missing from the assembly tree or the File Open dialog
box. On systems with this issue, when you start the application, it may display
the following error message:

Font Creation Failed

Also, the X11 log file (/var/log/Xorg.0.log) may contain error messages such
as the following:

FreeType: couldn't find encoding 'iso8859-15' for '/..../generic.ttf'.

This is a result of some Linux distributions failing to generate the encodings.dir
file during installation. X11 requires the encodings.dir file to load fonts in UTF-8
locales.

Workaround 1. Ensure that all X11 Unicode font packages are installed.

2. Navigate to the X11 fonts/encodings/ directory. On Red Hat Enterprise
Linux 6, this directory is located at /usr/share/X11/fonts/encodings, but
other distributions may put the encodings folder in a different location.

3. If the encodings.dir file does not exist in this location, generate the file
using the mkfontdir command. On Red Hat 6, type the following at the
command prompt:

cd /usr/share/X11/fonts/encodings
as root mkfontdir -e /usr/share/X11/fonts/encodings \
-e /usr/share/X11/fonts/encodings/large

Note

You must run the mkfontdir command from the directory
containing the encodings, and it should have a separate -e flag
for each subdirectory that also contains encodings, such as the
encodings/large/ subdirectory on RedHat 6.

4. If the encodings.dir file exists and the problem persists, check to make
sure that it includes encodings for each of the classes in the XLC_LOCALE

8-10 Release Notes 010221540

Chapter 8: Issues and workarounds



Issues and workarounds

file for the locale (in /usr/share/X11/locale/en_US.UTF-8/ on Red Hat 6, for
example), or regenerate the encodings.dir file using the above directions.

Visualization files are not associated with the viewer on OS X

Problem When you install Teamcenter lifecycle visualization on a Mac, the installer does
not automatically associate supported file types with the viewer. You must
manually associate supported file types with the viewer to do the following:

• Double-click a supported file type to open it in the viewer.

• Send visualization files from the Teamcenter Thin Client or Community
directly into the viewer.

Workaround In the Visualization application installation directory, there is a simple native
Mac OS X application called ViewerLauncher.app which you can associate
with Lifecycle Visualization file types.

When you double-click a visualization file type that has been associated with
ViewerLauncher.app, the application launches one of the following scripts:

• bin/vvbaselaunch

• bin/vvstdlaunch

• bin/vvprolaunch

By default, the script launched is vvprolaunch, which corresponds to the
Professional license level. You can modify the following file to specify a different
license level:

ViewerLauncher.app/Contents/Resources/English.lproj/Settings.txt

Note

If you are using Safari to send visualization files from the Teamcenter
Thin Client or Community directly into the viewer, you must also
configure the browser to treat .vvi files as safe files.

VVI files are not sent directly into the viewer on OS X

Problem When using the Teamcenter Thin Client or Community in Safari, .vvi files are not
sent directly into the viewer. Instead, the .vvi is saved to your local file system,
and you must manually open it in the viewer.
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Workaround You must configure Safari to treat .vvi files as safe files for visualization data
to open directly in the viewer. This behavior is controlled with a plist file
named “com.apple.DownloadAssessment.plist”. This file is packaged with the
ViewerLauncher.app. Copy it to this location:

${Home}/Library/Preferences

The key named “LSRiskCategorySafe” defines file types that are
treated as safe and automatically opened in the viewer. The subkey
“LSRiskCategoryContentTypes” defines an array of safe file extensions called
“LSRiskCategoryExtensions”, which must contain a string named “VVI”. Note
that the sample .plist file included with the installation is already configured to
treat .vvi files as safe.

Teamcenter Visualization is not installed to the Applications folder on OS X

Problem On Mac OS X, the Teamcenter lifecycle visualization application and related files
are not installed to the Applications folder.

Workaround If you want ViewerLauncher.app to be in the Applications folder, you must do
the following:

1. From the command prompt, move all of the visualization files and folders
at the same level as ViewerLauncher.app into the ViewerLauncher.app
application bundle (Mac .app files include a hidden folder structure, with the
top-level directory having a name that ends with the .app extension).

2. Move ViewerLauncher.app to the Applications folder.

Product views display parts in incorrect positions

Problem Parts may appear in incorrect positions when product views authored in the
Lifecycle Viewer or the stand-alone application viewer are restored in certain
Teamcenter embedded viewers. This problem occurs when the motion system
records part transformations on subassembly nodes, and the transformations
are subsequently captured by the product view. These assembly-level
transformations generated by the motion system are not applied correctly when
the product view is restored in Structure Manager, Multi-Structure Manager,
and Manufacturing Process Planner.

Workaround You can avoid this limitation by keeping 3D part transformations at the part level
when working with motion in the Lifecycle Viewer or the stand-alone application
viewer. Rather than transforming an entire assembly or subassembly, expand
the structure and select all of the individual parts and move them instead.

The help does not display properly in Internet Explorer 9

Problem When the Internet Explorer 9 Compatibility View setting is turned off, the help
does not display properly.
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Workaround To view the help in Internet Explorer 9, you must turn on Compatibility View. In
IE 9, do the following:

1. Choose Tools→Compatibility View Settings.

2. In the Compatibility View Settings dialog box, select the Display all
websites in Compatibility View check box.

An ActiveX warning is displayed each time the help is started

Problem When you launch the help, an ActiveX warning is displayed.

Workaround To get rid of the ActiveX warning, do the following:

1. Choose Tools→Internet Options→Advanced.

2. In the Settings area, scroll down to the Security section, and select the
Allow active content to run in files on My Computer check box.

3. Click OK.

4. Close and reopen the browser.

Rendering artifacts during moving frame navigation

Problem Lifecycle Visualization includes new technology to greatly increase the
interactivity of moving frame navigation for medium and large assemblies
on multi-processor workstations. This feature is automatically disabled on
single-CPU machines.

When you navigate rapidly about the 3D model, objects near the edge of the
Viewing window may be delayed for a few frames before appearing. This is a
normal side-effect of the performance enhancement. The severity of the effect is
proportional to the size of the assembly being viewed, the number of polygons
being rendered, and the speed of the graphics card.

Workaround To turn this feature off, you must set the environment variable
TCVIS_DISABLE_ASYNCSTRATEGY to True. However, you should disable
this feature only if your machine freezes or crashes.

Issue with nVidia G-Sync cards

Problem If you have an nVidia G-Sync option card, unexpected errors may occur when
using it in a PC cluster environment. Graphics adapters that support the nVidia
G-Sync option card include the nVidia Quadro FX graphics solutions.

010221540 Release Notes 8-13

Issues and workarounds



Chapter 8: Issues and workarounds

Workaround The problem has been fixed in nVidia driver version 197.28 and above. To
resolve the issue, update your driver.

If you are using an older driver, you can set up the following system environment
variable to disable the G-Sync effect in Lifecycle Visualization:

TCVIS_CLUSTER_NOGSYNC=True

Visibility filter and Use Off-Screen Rendering option

Problem When you turn off Use Off-Screen Rendering, the 3D graphics window must be
completely clear of other windows. If any windows are covering the 3D graphics
window in any way, the visibility check does not work.

Workaround It is recommended that you do not turn off Off-Screen Rendering.

Installing the Windows cluster service

Problem A cluster is a Windows-based system that contains multiple workstations. Before
you can use clusters, you must install an additional Windows service program
(TeamcenterVisClusterLaunch.exe) on the client nodes.

Workaround Install the Windows cluster service. For information on installing the service,
see Installing and uninstalling the Windows cluster service in the stand-alone
Lifecycle Visualization Installation Guide.

Functionality not supported in PC clusters

Problem Some functionality where new geometry or other content is generated
dynamically during the course of the session will not work with PC clusters,
including, but not limited to the following:

• Part edit

• Environment map image captures for advanced materials

• Jack

• Variation Analysis

• Visualization Illustration

• 3D compare

• Surface analysis

• Layer filters

• Animation file loading
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Workaround None

Attempting to interoperate an assembly to a new NX manager fails

Problem Interoperating an assembly to a new NX manager from Lifecycle Visualization
fails if the assembly was originally sent to Lifecycle Visualization from
Teamcenter.

Workaround Start NX from Teamcenter before interoperating an assembly from Lifecycle
Visualization. From the File→Interoperate menu in Lifecycle Visualization,
choose the running NX manager instead of a new NX manager.

Assembly names are different when sent from NX and Teamcenter

Problem If an assembly is sent to Lifecycle Visualization directly from Teamcenter, the
name in the assembly tree view has the Item ID, ItemRev, and ItemName. The
Item ID, ItemRev, and ItemName are not present if the assembly is sent from NX.

Workaround A solution where the Item ID, ItemRev, and ItemName are sent to Lifecycle
Visualization as user data in the PLM XML is in NX 5.0.2 and later releases.
This solution allows a Lifecycle Visualization user to add these as columns in the
Assembly Tree. A longer term solution also is under investigation.

Session files lose association to animation files

Problem On Linux, you will encounter issues when you have a session file that references
an animation primary document. When a 3D view from the session file is
associated with the animation, that relationship should be preserved and
re-established when you open the session. However, on Linux the relationship
between the 3D view and the animation does not get re-established. Therefore,
if you run the animation, it attempts to create a new 3D view instead of using the
one that is present as part of the session.

Workaround Perform the following steps:

1. Load the session (this loads the 3D view and the animation document).

2. Select the 3D view to be the animation target.

3. Select a part in the Viewing window.

4. Choose Animation→Associate 3D View with Animation.

Cannot save PLM XML motion file formats to Teamcenter

Problem When you try to save motion data to Teamcenter using the PLM XML Motion
Frame or PLM XML Motion Keyframe file formats, an error message is displayed.

Workaround You must use the VFM file format when saving motion data to Teamcenter. The
PLM XML motion file formats are not supported.
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Support for localized user interface in Visualization Illustration

Problem The language shown on the user interface may be inconsistent when using
Visualization Illustration.

Workaround To provide a consistent user interface with respect to the user interface language
presented by the viewer and the user interface language presented by the Visio
Drawing Control, you must install one of the following:

• An English Visio 2010, 2013, or 2016 product install and a MUI pack
supporting the language of choice

• A localized Visio2010, 2013, or 2016 product install for the language of
choice

Only when the Microsoft Office 2010 or Visio 2013 Language Settings tool has
the user interface language set to the same language as specified for the default
system locale will the user interface language be consistent throughout the
entire Visualization Illustration application.

In non-English versions of Visualization Illustration, opening an SVG file containing Assets
displays a blank screen.

Problem Opening an SVG file containing Assets displays a blank screen when Windows
is configured to use a comma as the decimal symbol.

Workaround Configure Windows to use a period as the decimal symbol.

1. Open Windows Control Panel.

2. Choose Region and Language.

3. In the Region and Language dialog box, on the Formats tab, click
Additional setting.

4. In the Customize Format dialog box, on the Numbers tab, change Decimal
symbol from "," to ".".

Visualization Illustration asset capturing may stop working after uninstalling Lifecycle
Visualization

Problem After uninstalling Lifecycle Visualization when a previous version of Lifecycle
Visualization is still installed, you may need to repair the previous installation to
restore the proper functioning of the previous version of Asset Capture. This
problem results in the following error message: Failed to create the session

data container.
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Workaround 1. From the Common Files installation folder (for example, C:\Program
Files\Common Files\Siemens Shared\TcVis\9.1\), remove the module
VP3DGeomAssetData.dll.

2. Run the repair option of the installation of the earlier version of Lifecycle
Visualization.

Visualization Illustration enablement

Problem Visualization Illustration users may notice that even though they have installed
Visualization Illustration, they are not seeing certain functionality exposed. In
particular, the following:

• The Asset Clipboard does not appear when a 3D view is opened.

• You cannot capture a 3D geometry asset.

Workaround The first and most obvious reason for this may be a lack of a new Visualization
Illustration license.

The second reason for this may be the absence of a Visio 2010, 2013, or 2016
installation. If either of these is not available, Visualization Illustration and all
related functionality will be disabled.

Microsoft installer launches on start of Visio

Problem The Lifecycle Visualization installer does not associate the Visio .vsd file type
with Visio. As a result, double-clicking a .vsd file causes the Visio application
to launch and load the document. However, because Visualization Illustration
Technical Illustrations are built using Visio as a drawing engine, Technical
Illustrations are Visio documents with a .vsd extension. As a result, there are
some users that elect to associate the Viewer with the .vsd file type. By doing so,
double-clicking a .vsd file causes the Viewer to launch and load the document.
Regardless of which application is associated with the .vsd file type, .vsd files
can always be opened in the Viewer through File →Open.

If Microsoft detects during the startup of Visio that the .vsd file is not
associated with the Visio application, the Microsoft Installer runs as a means to
automatically repair what Microsoft views as a broken association. A description
of this behavior can be found at http://support.microsoft.com/?id=290997. At
the bottom of this article is a link that describes how to disable this behavior.
However, this approach completely disables the Microsoft Installer.

Workaround A workaround for this problem is to not associate the .vsd file type with the
Viewer. Rather than double-clicking the .vsd file type to launch the application,
right-click the .vsd file and use the Microsoft Explorer Open With shortcut menu
to open the file.
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Variation Analysis issues

Problem The following issues apply to Variation Analysis.

• When extracting NX PMI data from a JT file, slot and tab patterns are not
supported.

• When extracting NX PMI data from a JT file, the following tolerances do
not flow down to Variation Analysis.

o PMI shown in multiple NX views are duplicated in JT PMI and
subsequently in the Variation Analysis.

o Unilateral and unequal bilateral profile tolerances indicated by the
modifier are not recognized.

• Reference dimension and angular plus-minus tolerances are not recognized.

• The flowdown of linear plus-minus tolerances (directed dimensions in NX
PMI) require NX 10 or later.

• Rename/Remap does not work when the object being moved is the
assembly node that is being duplicated.

• FCFs (Feature Control Frames) show a non-existing datum reference when
a feature is linked to the tolerance library.

Workaround None
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Teamcenter lifecycle visualization supports the following file formats:

• 2D file formats

• 3D file formats

• ECAD file formats

• 2D/3D file formats

• Lifecycle Visualization authored file formats

• Motion file formats supported for conversion to VFM

• Visualization Illustration supported file formats

• Lifecycle Visualization file formats

• Supported versions of the JT file format

• Supported versions of other Siemens PLM Software file formats

Note

• Some file types may need an optional translator. Consult your system administrator
for assistance.

• To view, convert, and print Office documents, you must have Microsoft Office installed.

• To avoid seeing construction geometry in Lifecycle Visualization, clean up your
construction geometry in NX before opening the file in the viewer.

• Non-geometry data, such as PMI, is not supported.

• Wireframe data is not supported.

• 2D .prt files must contain embedded CGM data.

2D file formats

You can open the following 2D file formats:

Abbreviation Extension Description Type Prerequisites
Raster and Document
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Abbreviation Extension Description Type Prerequisites
BMP .bmp Microsoft Windows or OS/2

bitmap file
Raster None

C4 .C4 JEDMICS C4 tiled raster
format

Raster None

CG4 .CG4 CALS Group IV format Raster None
DOC .doc Microsoft Word Document Install MS Word
DOC .docx Microsoft Word Document Install MS Word
DFT (Windows
only)

.dft Solid Edge draft files

Note

For details
on supported
versions, see
Supported
versions of other
Siemens PLM
Software file
formats.

Raster None

EMF (Windows
only)

.emf Microsoft Enhanced
Metafile

Raster None

GIF .gif CompuServe color raster
format

Raster None

HDR .hdr High Dynamic Range
images

Note

High Dynamic
Range (HDR)
images are
supported for 3D
light maps only.
Light maps can
use OpenEXR or
Radiance RGBE
Encoding HDR
images.

Raster None

JPEG .dept, .jpeg,
.jiff, .jpe, .jpg

JPEG file Raster None
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Abbreviation Extension Description Type Prerequisites
JPEG 2000 .j2k, .jp2, .jpc JPEG 2000 file

Note

Using
Teamcenter
Visualization
2005 and later,
you can display
and save JPEG
2000 files.

Raster None

MLR .mlr, .mil, .milr,
.CAL

MIL-R-28002 Type 1 Raster Raster None

MPP .mpp Microsoft Project Document Install MS Project
MPC .mpc Multi-page CALS file Raster None
PBM .pbm Portable BitMap image file

Note

The application
only supports
viewing this file
type.

Raster None

PCX .pcx Windows Paintbrush image
file

Raster None

PGM .pgm Portable GrayMap image
file

Note

The application
only supports
viewing this file
type.

Raster None

PNG .png PNG file format Raster None
PNM .pnm Portable AnyMap image file

Note

The application
only supports
viewing this file
type.

Raster None
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Abbreviation Extension Description Type Prerequisites
PPM .ppm Portable PixMap image file

Note

The application
only supports
viewing this file
type.

Raster None

PPT .ppt Windows PowerPoint Document Install MS
PowerPoint

PPT .pptx Windows PowerPoint Document Install MS
PowerPoint

PS .ps, .eps PostScript (Level 1, Level
2, EPS)

Raster Install Ghostscript

RAS .ras, .sun Bi-level Sun raster Raster None
RGB .rgb .rgba, .sgi

.bw
SGI RGB file Raster None

RVF .rvf Raster Viewing Format Raster None
TG4 .tg4 CCITT Group 4 Type II tiled

image format
Raster None

TGA .tga Truevision Targa Raster None
TIFF .tif, .tiff Tagged Image File Format Raster None
TLC .tlc TLC file format Raster None
TRIFF .fsx, .ovx., .fs,

.ov
Monochrome, single and
multi-page tiled raster file
format

Raster None

WBMP .wbmp Wireless Bitmap Raster None
WMF (Windows
only)

.wmf Windows Metafile Raster None

XLS .xls, .cvs Microsoft Excel Document Install MS Excel
XLS .xlsx, .cvs Microsoft Excel Document Install MS Excel

Vector
907 .906, .907,

.CAL
Calcomp 906, 907 Vector None
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Abbreviation Extension Description Type Prerequisites
CGM .cgm Binary Computer Graphics

Metafile MIL-D-28003 ANSI
X3.122

Note

Teamcenter
Visualization
2005 and later
supports CGM
Version 4, while
maintaining
support for
CGM Versions
1 through 3.

Teamcenter
Visualization
2005 also
supports
WebCGM files.

Vector None

DGN (Windows
only)

.dgn Microstation DGN file format
(available on Windows)

Vector None

DWF .dwf Autodesk Drawing Web
Format files

Note

The application
supports DWF
version 6
formatted files,
including the
new .w2d file
extension.

Embedded
raster data is
supported only
on Windows.

Vector None
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Abbreviation Extension Description Type Prerequisites
DWG .dwg AutoCAD Internal file format

Note

The following
types of
embedded
raster data are
supported: BMP,
JPG, GIF, MLR,
TIFF, and PNG.

Vector None

GERBER .gbr, .gbx, .gvl Gerber RS274D and
RS274X formats

Note

Use .gvl files to
open a list of
Gerber files as
one document
with layers for
each file in the
list.

Vector None

HPGL .hgl, .hpg,
.hpgl, .hp2,
.plt

HP Graphics Language
(HPGL and HPGL/2)

Note

The application
recognizes
additional files as
HPGL if you set
the EAI_HPGL_
EXTENSIONS
environment
variable. The
setting should
be a comma
separated list of
file extensions.

Example

"hpgl2,hpgl3"

Vector None
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Abbreviation Extension Description Type Prerequisites
IDW (Windows
only)

.idw Autodesk Inventor drawing
file format

Vector To work with the
Autodesk Inventor
files, you must
have Autodesk
Inventor, Autodesk
Inventor View, or
Design Tracking.
Autodesk Inventor
View and Design
Tracking are freely
distributed and
available from
Autodesk.

Autodesk Inventor
.idw files prior to
version 5.3 are not
supported.

IGES .igs, .iges Initial Graphics Exchange
Input File Specification,
MIL-D-28000

Vector None

MDL .mdl Model file Vector None
W2D .w2d Autodesk toolkit Vector None

Miscellaneous
AI .ai Adobe Illustrator Vector or

Raster
For Linux, and
Mac, install
Ghostscript

MDS .mds MetaData Stamp Vector or
Raster

None

PDF .pdf Portable Document Format

Note

On Windows,
you can directly
create and
work with PDF
documents.

Raster For Linux, and
Mac, install
Ghostscript

TXT .txt ASCII text file format Document None
WebCGM .cgm CGM file management

through Web browsers,
hyperlinks, and other
supported WebCGM file
features.

None None
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Abbreviation Extension Description Type Prerequisites
ZIP .zip ZIP files containing one or

more files of a supported
2D format

Note

The 2D files
contained within
the ZIP file are
displayed in a
single multipage
2D image
window. You can
navigate through
the pages (files)
using any of
the available
2D multipage
navigation
options.

None None

7-Zip .7z

7-Zip files containing one or
more files of a supported
2D format

Note

The 2D files
contained within
the 7-Zip file
are displayed
in a single
multipage 2D
image window.
You can navigate
through the
pages (files)
using any of
the available
2D multipage
navigation
options.

3D file formats

You can open the following 3D file formats:
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Abbreviation Extension Description
ASM (Windows
only)

.asm Assembly file for Solid Edge that can reference .par, .psm,
.pwd, and other .asm files.

Note

For details on supported versions, see Supported
versions of other Siemens PLM Software file
formats.

BLK .blk NASTRAN bulk format
IGES 5.3 .igs, .iges Initial Graphics Exchange Input File Specification,

MIL-D-28000

Note

To work with IGES files, the IGES optional
translator must be properly installed and licensed.

JT .jt DirectModel file format
PAR (Windows
only)

.par Solid Edge single part file

Note

For details on supported versions, see Supported
versions of other Siemens PLM Software file
formats.

PLM XML .plmxml XML format that supports product view and product structure
data

PSM (Windows
only)

.psm Solid Edge sheet metal file

Note

For details on supported versions, see Supported
versions of other Siemens PLM Software file
formats.

PWD
(Windows only)

.pwd Solid Edge weldment file

Note

For details on supported versions, see Supported
versions of other Siemens PLM Software file
formats.
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Abbreviation Extension Description
RES .res ADAMS results file format

Note

• Lifecycle Visualization supports ADAMS RES
2010 and 2013 files.

• The ADAMS conversion feature, which
converts RES files to the VFM motion file
format, requires the Professional or Mockup
product configuration, as well as an additional
license. It is supported on Windows only.

STEP AP203,
214

.stp Standard for Exchange of Product

Note

To work with STEP files, the STEP optional
translator must be properly installed and licensed.

VRML .wrl, .vrml Virtual Reality Markup Language

Note

• VRML support is for geometry and appearance
attributes only.

• You can export 3D models in only the VRML
1.0 format.

• Both VRML 1.0 and 2.0 files can be imported.

XMO .xmo XML-based motion file format
XT .x_t, .x_b, .xmt_txt,

.xmt_bin
Parasolid XT File

Note

For details on supported versions, see Supported
versions of other Siemens PLM Software file
formats.

Note

The CADDS format is no longer supported. You can use the CADDS to JT translator
to translate single CADDS files or to perform automated batch translations of multiple
CADDS files.
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ECAD file formats

You can open the following file formats in ECAD:

Abbreviation Extension Description
BCZ .bcz Teamcenter Briefcase
XFATF .xfatf PCB file
XSCH .xsch Schematic File
XRUL .xrul Contains the ECAD DFx rules.
XRES .xres Contains the ECAD DFx results.
CGM .cgm ECAD Markup layer.

2D/3D file formats

You can open the following 2D/3D file formats:

Abbreviation Extension Description
DXF .dxf AutoCAD drawing interchange format

Note

• To work with 3D DXF files, the DXF optional
translator must be properly installed and
licensed.

• The following types of embedded raster data
are supported: BMP, JPG, GIF, MLR, TIFF,
and PNG.

• Solids are not supported.

DWG .dwg AutoCAD Internal file format

Note

The following types of embedded raster data are
supported: BMP, JPG, GIF, MLR, TIFF, and PNG.

IGES .igs, .iges Initial Graphics Exchange Input File Specification,
MIL-D-28000

Note

To work with IGES files, the IGES optional
translator must be properly installed and licensed.
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Abbreviation Extension Description
PRT .prt NX part file

Note

Lifecycle Visualization supports direct viewing of
NX .prt files. For details on supported versions,
see Supported versions of other Siemens PLM
Software file formats.

Lifecycle Visualization authored file formats

You can save data as the following file formats:

Abbreviation Extension Description
907 .907 Calcomp 907
951 .951 Calcomp 951
AVI .avi Video (Windows)
BCZ .bcz Teamcenter Briefcase
BMP .bmp Microsoft Windows or OS/2 bitmap file
CGM .cgm 2D Markup layer or ECAD
CSV .csv Clearance DB report
DBC .dbc Clearance DB Database Connection
ENV .edv Jack Environment (session)
FIG .fig Jack Figure (session)
GIF .gif Graphics Interchange Format

Note

You must have a license to work with Visualization
Illustration.

HPGL .hpg HP Graphics Language (HPGL and HPGL/2)
J2K .j2k, .jp2, .jpc JPEG 2000
JPEG .jpg JPEG file

Note

You must have a license to work with Visualization
Illustration.

JT .jt DirectModel Format
MLR .mlr, .mil, .milr MIL-R-28002 Type 1 Raster
MPEG .mpg Video (Mac and Linux)
P-SURF .pss Jack P-Surface (Part)
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Abbreviation Extension Description
PCX .pcx Windows Paintbrush image file
PDO .pdo Process documents
PFC .pfc Vehicle Integrated Process Flow Charts
PLMXML .plmxml Product Structure
PNG .png PNG file format

Note

You must have a license to work with Visualization
Illustration.

PS .ps PostScript (EPS)
PVL .pvl 2D Image View List
ROBFACE .asy Robface format
RVF .rvf Raster Viewing Format
SCD .scd Sensor Configuration Definition
STEP AP203 .stp Standard for Exchange of Product

Note

To work with STEP files, the STEP optional
translator must be properly installed and licensed.

SVG .svg Scalable Vector Graphics

Note

You must have a license to work with Visualization
Illustration.

TIFF .tif Tagged Image File Format
TXT .txt 3D Measurement Report, 3D PMI Point Report, Clearance

Results
V3G .v3g 3D Geometry Asset
VAN .van Animation
VCD .vcd Video Configuration Definition
VF .vf Work sessions
VFM .vfm Motion
VFZ .vfz Work Session Package
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Abbreviation Extension Description
VML .vml Vector Markup Language

Note

You must have a license to work with Visualization
Illustration.

VPL .vpl 3D markup layers
VRML .wrl Virtual Reality Markup Language

Note

• VRML only supports geometry.

• You can export 3D models in only the VRML
1.0 format.

• Both VRML 1.0 and 2.0 files can be imported.

VSD .vsd Technical Illustration
VTP .vtp Technical Portfolio
VVS .vvs Viewer State Script
XML .xml Attribute Color, Search Trace Results file, SPC measurement

data file, XML point import and export file, exported Flowchart
file, ECAD markup metadata file

XRUL .xrul Contains the ECAD DFx rules.
XRES .xres Contains the ECAD DFx results.
ZN .zn Clearance Zone

Motion file formats supported for conversion to VFM

You can convert the following file types to the VFM motion file format:

Note

VFM files saved in Lifecycle Visualization 11.6/12.1 are not compatible with earlier releases
of Lifecycle Visualization.

Abbreviation Extension Description
XMO .xmo Motion
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Abbreviation Extension Description
RES .res ADAMS Results Files

Note

• Lifecycle Visualization supports ADAMS RES
2010 and 2013 files.

• The ADAMS conversion feature, which
converts RES files to the VFM motion file
format, requires the Professional or Mockup
product configuration, as well as an additional
license. It is supported on Windows only.

Visualization Illustration supported file formats

Note

You must have a license to work with Visualization Illustration.

You can work with the following file formats in Visualization Illustration:

Abbreviation Extension Description
BMP, DIB .bmp, .dib Windows Bitmap
EMZ .emz Compressed Enhanced Metafile
EMF (Windows
only)

.emf Enhanced Metafile

GIF .gif Graphics Interchange Format
JPEG .jpg JPEG Interchange Format
PNG .png Portable Network Graphics
SVG, SVGZ .svg, .svgz Scalable Vector Graphics
TIF, TIFF .tif, .tiff Tag Image File Format
VML .vml Vector Markup Language

Lifecycle Visualization file formats

Lifecycle Visualization features utilize the following file formats:

Abbreviation Extension Description
CSV .csv ClearanceDB report
DBC .dbc ClearanceDB Database Connection file
ENV .edv Jack Environment (session)
FIG .fig Jack Figure (session)
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Abbreviation Extension Description
eXT .ext ASCII XML format developed by Parasolid

Note

The application no longer saves data in the .eXT
format. You can read .eXT files, but you can save
product view data only in the .plmxml format.

JT .jt DirectModel Format
PDO .pdo Process documents
PFC .pfc Vehicle Integrated Process Flow Charts
P-SURF .pss Jack P-Surface (Part)
PLMXML .plmxml Product Structure
VAN .van Animation
VBK .vbk Illustration Book
VF .vf Work sessions
VFM .vfm Motion
VFP .vfp Autofile Locate preferences file.
VFZ .vfz Work Session Package
VPL .vpl 3D markup layers
XML .xml Attribute Color, Search Trace Results file, SPC measurement

data file, XML point import and export file, exported Flowchart
file

XMO .xmo Motion
ZN .zn Clearance Zone

Supported versions of the JT file format

You can open and, depending upon your licensing configuration, save the following versions of
the JT file format:

Teamcenter lifecycle visualization
version

JT version JT and XT B-Rep
support

ULP support

5.x 8.1 and earlier Yes No
6.x 8.1 and earlier Yes No
2007 (PLM1) 8.3 and earlier Yes Preliminary
2007.1 9.1 and earlier Yes Yes
2007.1.1 9.2 and earlier Yes Yes
8.0 9.3 and earlier Yes Yes
8.1 9.4 and earlier Yes Yes
8.2 9.5 and earlier Yes Yes
8.3 9.5 and earlier Yes Yes
9.x 9.5 and earlier Yes Yes
10 9.5 and earlier Yes Yes
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Teamcenter lifecycle visualization
version

JT version JT and XT B-Rep
support

ULP support

10.1 10.0 and earlier Yes Yes
11.1 10.0 and earlier Yes Yes
11.2 10.2 and earlier Yes Yes
11.3 10.2 and earlier Yes Yes
11.4 10.2 and earlier Yes Yes
11.5 10.2 and earlier Yes Yes
11.6 10.2 and earlier Yes Yes

Supported versions of other Siemens PLM Software file formats

For information about the supported versions of other Siemens PLM Software file formats,
see the Interoperability matrix on the Hardware and Software Certifications page on GTAC:
https://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.
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Chapter 10: Global Technical Access Center (GTAC)

To report any serious problems about Lifecycle Visualization, please contact the Global Technical
Access Center.

Phone:

• USA and Canada: (800) 955-0000 or (714) 952-5444

• Outside the United States and Canada: Contact your local support office.

Website:

You can also log and view any existing resolutions for incident reports on the Web at
http://www.siemens.com/gtac.
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